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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave 
 

A reader can't hook up a printer to his network; after a month-long hiatus, a 
Windows 7 computer's mouse is inexplicably frozen; and a tip on using Google's 
new Instant Search feature.

 

 
Digital Dave, 
 
I'm trying to add my network printer, an HP OfficeJet G85, to my network, but nothing seems to 
work. In addition to the main PC, which runs Windows XP, and to which my printer is wired 
(USB), I have two laptops running Vista and another one running Windows 7. None of the 
laptops are able to connect to the printer. When I try to Add a Printer, I either get "Not enough 
server storage is available to process this command," or I get "Windows cannot connect to the 
printer. Operation could not be completed (error 0x0000046a)." 
 
Now that my kids are back in school and they have assignments to print, I am desperately in 
need of help. Any ideas? 
 
Steve 
Denver 
 
Dear Steve, 
 
One of the most common questions I get is about sharing printers with mixed Windows 7, Vista 
and XP computers. There are a number of steps required, such as ensuring that the printer is 
shared by the host computer. However, it seems that your situation is most likely caused by a 
problem on the Windows XP host computer—probably the antivirus software (Norton's). 
Microsoft does have a fairly complex fix (support.microsoft.com/default.aspx?scid=KB;EN-US;
q177078) for the problem. Rather than go through this fix, I would either change the antivirus 
software or use a network print server. 
 
Another option would be to get a network print server device. These are relatively low cost and 
will connect either with Ethernet or Wi-Fi (or both). The USB printer will plug directly into the 
print server. This will remove the Windows XP machine as the source of the problem and allow 
direct access to the printer from all network computers. The printer server will be assigned its 
own IP address that can be used by each computer to connect to the printer. (This is only 
necessary if the printer isn't automatically visible on the network.) This is a much cleaner 
solution than making one computer the printer server. 
 
Digital Dave 
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Dear Digital Dave, 
 
I am an enthusiastic computer builder, but I like to build cheap. So, I wait a year and save 50 
percent. Anyway, I wanted to use four gigs in this next build, so I bought and installed Windows 
7 Home Premium. It ran great; I was very happy. I set it aside until I had time to fully configure it 
for about a month. I fired it up to finish, and 10 minutes into the process the mouse froze. I 
configured new hardware and did a restart, but no joy. I changed the port, changed the mouse. 
Went online—lots of people are having this problem. Went to Microsoft, but found their "fix" 
didn't work for me or anyone else. Dave, help. I don't want to go back to a 32-bit OS. 
 
Bob Morgan 
Imperial Beach, CA 
 
Dear Bob, 
 
You shouldn't need to go back to a 32-bit operating system. You had the system working a 
month ago, you should be able to get it up and running again. The fact that "lots of people" are 
having this problem does not reflect the true nature of the situation. With millions of people using 
Windows 7, there are bound to be a number of hits on the Web. That doesn't mean that all the 
similar symptoms are all caused by the same problem. It's often difficult to analyze whether it is 
a hardware or software problem, but the vast majority of Windows 7 machines are operating just 
find. I personally have experienced only occasional driver problems, but once running, a 
Windows 7 computer is one of the most stable computers I've ever used—next to Linux. 
 
You may want to use an earlier restore point to see if you can get it back to the original 
operating status. That's if the computer will run long enough to do a restore. There may be an 
updated driver that caused the problem. 
 
Failing that, in your situation, I would do a clean install of Windows 7. It is possible that 
something is corrupted in the OS. Since you haven't done much with the computer, a clean 
install may be easier (and cleaner) than trying to correct corrupted files. If it is a hardware or 
driver issue, it may be easier to isolate it during the installation process. Hopefully, the computer 
will operate as it did the last time you loaded Windows. 
 
The other thing that I would have done during the month-long computer hiatus is leave the new 
computer turned on, plugged into the Internet and doing automatic updates. I've found that 
Windows 7 computers will often fix themselves over time. (I know that it sounds like magic, but 
this has happened to me a couple of times.) There is a process that occurs with Windows 7 
where issues are identified and corrected during the updates. Believe it or not, if you let the 
computer sit (while attached to the Internet) many issues may be solved over time. 
 
Digital Dave 

 

 
Digital Dave’s Tip 
 
I'm a regular user of Google, although I have given other search engines a try. I've never found 
anything exciting enough to get me to change. After all, how much can be done with a search 
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engine? Sure, things can be made to look a little different, but they all tended to be variations on 
vanilla ice cream. I didn't think that there could be a change that would truly impress me. I was 
wrong. 
 
One would expect that Google, being the king of search engines, would relax a little bit. Their 
name is synonymous with Internet search—which is the goal of any company that dominates a 
market. Yet Google has innovated in a way that will bring many more people into the fold. (As if 
Google doesn't already own enough of the market.) Their recent changes to how the Google 
search works are truly remarkable. Now if you're sitting at the computer, waiting by the phone 
for the "phone a friend" call from a game show, you have a little bit more of an edge. 
 
If you have Instant Search (type to search) turned on in Google, then as you enter your search 
term Google will instantly return results. No longer do you need to click the Search button (or hit 
the Enter key). While this may seem trivial, it's a great help when you are trying various 
searches. Rather than needing to reload the page for a new search, the search changes as you 
enter each letter. For example, when you search for information on Queen Elizabeth, as the 
name is typed in the page will change to appropriate searches (see Figure 1). 
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Figure 1. Google search for Elizabeth I without clicking the Search button.

 
 
By adding the letter I to the text string, the search jumps from Elizabeth I to Elizabeth II (see 
Figure 2). 
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Figure 1. Google's instant search for Elizabeth II makes the Search button redundant.
 
 
In addition to the drop-down options, the search box will also include grayed auto-complete 
recommendations similar to those found in word processors. Hit the tab key and the words will 
be completed while doing the new search. Click the X at the right and get a blank field and 
screen for a new search. 
 
The only thing cooler would be for Google to conduct searches directed by your brain waves. Is 
that coming next? 
 
Digital Dave 
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Alternatives to Microsoft Office
“Just because 80 percent of the world uses Office doesn't mean you have to.” by Pete Choppin 
 

Aside from having bugs and security problems, Microsoft Office has a big drawback—its price tag. But fear not: 
There are viable alternatives to Microsoft Office, and a number of them are totally free.

 
 
I have a hard time finding anyone—Linux and Windows users alike—who doesn't use Microsoft Office in 
some way. This product is so widely used, it is almost impossible to share documents without it. According 
to Forrester Research, as of June 2009, some version of Microsoft Office is used in 80 percent of 
enterprises, and 64 percent of enterprises use the 2007 Office version. That is near the percentage of 
Windows operating systems in use on the market.  
 

This is not to say the product is flawless. 
Aside from having many bugs and numerous 
security problems, Microsoft Office has one 
other big drawback—the software costs a 
small fortune. It may be a surprise to many, 
but there are viable alternatives to Microsoft 
Office, and a number of them are totally 
free.  
 
How did such expensive and bug-ridden 
software get to be the standard office 
productivity suite? Microsoft accomplished 
something that had eluded other software 
providers: It created a highly integrated suite 
of products that had a similar look and feel, 
and it got the job done. The original license 
terms were attractive for businesses. The 
license was based on concurrent usage. 

Companies could install a server copy and 
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they only had to pay for the maximum number of copies of the software that were in use simultaneously. 
By the time Microsoft eliminated the concurrent licensing, its software was well entrenched in the business 
mainstream.  
 
The most current version of Microsoft Office is 2010. With the current licensing scheme, you will pay a 
minimum of $199 for the Home and Business version of the product. This will license one computer. As an 
alternative, you can purchase the boxed set for $279, and this will give you three licenses. If you need the 
Professional version, this will cost $349 for the single license and $499 for the boxed set. The cost of using 
Microsoft Office has become more than many businesses wish to tolerate. There have been free 
alternatives to Microsoft Office for some time, but now it's not only home users who have become 
interested. Here are some of these alternatives.  
 
OpenOffice.org 
 
This is probably one of the better-known free office suites. OpenOffice.org (www.openoffice.org) is both 
the name of the group coordinating the development and the software product that has resulted from their 
efforts. OpenOffice.org contains everything you'd expect in an office suite: a word processor, spreadsheet 
application, presentation package, formula editor, drawing program, data charting application, HTML 
editor and file filters that enable the importing and exporting of various formats.  
 
The latest OpenOffice 3.2 supports all the Office 2007 formats out of the box. That said, the conversion 
process still isn't completely perfect, especially if you're trying for pixel-perfect document formatting or 
spreadsheets with complicated equation cells.  
 
The latest version of OpenOffice isn't all about format wars, though, and version 3.2 has made considerable 
speed boost improvements—especially in startup times.  
 
ThinkFree 
 
I've written about Web-based office solutions before, and ThinkFree (www.thinkfree.com) is one of several 
Web-based solutions out there. ThinkFree is also Java based—which means it is cross-platform compatible 
and does not restrict you to having to use Microsoft's products. If you are looking for an alternative to 
Microsoft Office, but you need to remain compatible, ThinkFree can't be beat.  
 
Similarities to Microsoft Office are downright eerie—the charting wizard in ThinkFree Calc looks just like 
Excel's and supports all of Excel's chart types. However, ThinkFree isn't completely compatible with 
Office. For example, you can't create a PivotTable, and conditional formatting—in which the background 
color of a cell varies by its value using settings you provide—is not supported in Calc. Also, be advised 
that "template" and "macro" are concepts ThinkFree Write and Calc applications don't understand.  
 
ThinkFree does have many great features. It is fast and responsive. The only downside is, of course, that it 
is Web based. All your files are hosted on the company's servers. If this is something that does not appeal 
to you, then ThinkFree may not be the right solution. But for an Office solution that is available wherever 
you are and compatible with Microsoft, ThinkFree fits the bill.  
 
Other Alternatives 
 
There are a number of other office suites available. Here is a list of these Free or Low Cost Office Suites 
(www.freebyte.com/office/). Feel free to download any of these and give it a try. All of the downloads are 
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large, so if you have a slow Internet connection, you might want to ask a friend with broadband to do the 
download for you and burn it to CD. All the products listed provide applications that are powerful enough 
for most users. You may even find yourself feeling some satisfaction that the Microsoft monopoly no 
longer owns one little corner of your computing world.  
 
There are many great alternatives to Microsoft Office. And even though more than 80 percent of the world 
is using Office, it doesn't mean you have to. Take a look and see what works and what doesn't. The good 
news is that many alternatives are free, so all it will cost you is time. 
 

Pete Choppin has been an IT Professional for over 15 years. He currently works as a network and systems 
administrator for a company called Albion based in Clearfield, Utah. He has experience in all types of 
hardware, software, and networking technologies. He is proficient in many operating systems including 
Linux, Windows and Macintosh. His interests include cooking, sci-fi, computers and technology, and Web 
design—a semi-professional endeavor, having designed Web sites in the dental field, e-commerce 
businesses, and for the Boy Scouts of America.  
 
Pete has been a devout reader of ComputorEdge since 1990 and contributes regularly to featured articles as 
well as the Linux Lessons section of ComputorEdge. He can be contacted at pchoppin@comcast.net but 
prefers to have comments on ComputorEdge articles submitted to the editor and posted for the benefit of 
all readers. 
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Zoho Office Productivity Tools
“Google Docs isn't the only game in town.” by Michael J. Ross 
 

Google Docs isn't your only option for Web-based productivity software. Zoho offers 21 applications, in addition 
to several utilities that allow you to create and manage online tests and polls, monitor Web sites, view uploaded 
documents, and optionally share them with other people.

 
 
Of the many ways that the Internet is transforming our personal and business lives, the one that has 
arguably received less attention than it deserves is the movement of data storage and processing 
functionality from the desktop to the Web. This trend has been in progress since the earliest days of Web 
pages and sites. But it really gained momentum with the introduction of Web-based e-mail services, such 
as Yahoo Mail, in which the software is running on a Web site instead of locally on the user's hard drive. 
 
Individual office productivity applications, such as WordPerfect and Microsoft Word, as well as office 
productivity suites such as Microsoft Office, have long resided on the desktop. In fact, even when the Web 
had penetrated the business world and workers were comfortable visiting Web sites and sending e-mail 
messages, the majority of such people would never have imagined that those long-dominant desktop 
programs would ever be seriously threatened by Web-based alternatives. But that is exactly what has 
happened. For instance, Google Docs (docs.google.com/) is the company's free online service for creating, 
modifying and distributing documents, spreadsheets and presentations, as well as storing files of all types. 
As a consequence, a growing number of companies and other organizations are abandoning their Microsoft 
Office installations—and the licensing fees—and opting instead for the Google solution. 
 
Yet Google is not the only player in town. There are other free office productivity suites, for both the 
desktop and the Web. An excellent example of the former is OpenOffice.org (www.openoffice.org/), and an 
example online is Zoho (www.zoho.com/). As is evident from its homepage, Zoho offers 21 applications, in 
addition to several utilities that allow you to create and manage online tests and polls, monitor Web sites, 
view uploaded documents, and optionally share them with other people. The applications are divided into 
two groups—those for productivity and collaboration (presumably valuable for noncommercial purposes), 
and those specific to business use. 
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Figure 1. Zoho applications.

 
 
All of the Zoho applications can be used free of charge by an individual, while some of them require a 
subscription fee if and when they are used by an organization. As further evidence of the company's 
commitment to openness and interoperability, you can create and log into your Zoho account utilizing any 
existing access from Google, Google Apps, Yahoo or Facebook. If you choose to log in this way, then 
when you try to do so the first time, you will be prompted to create a Zoho username, which you will use 
for all future login attempts. 
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Once you have successfully created a Zoho account, you will have access to not only most of the Zoho 
services (without having to create separate accounts for each one), but you will also be able to review and 
update your account information—organized into four categories: Home, Profile, Settings and Groups. 
 

 
Figure 2. Zoho account.

 
 
Turning to the topic of the applications themselves, 21 apps are simply too many to discuss in a single 
article, so the focus here will be on three of the apps that would likely be of great value for office 
productivity—specifically, e-mail services, word processing and spreadsheets. 
 
E-Mail Online 
 
The number of business communication methods continues to grow, as traditional methods (such as postal 
mail) are supplemented or replaced by much more modern methods (such as Internet-based telephony). Yet 
the primary means of global communication, in both the commercial and noncommercial sectors, is 
undoubtedly e-mail—even when taking into account that the bulk of e-mail nowadays is spam. Web 
companies of all sizes and sectors offer e-mail services, and Zoho is no exception. 
 
Zoho Mail (mail.zoho.com/) does not display advertising of its own (unlike Google's Gmail), and it does its 
best to filter out the unwanted advertising of spammers. You can choose to have an e-mail address that 
incorporates Zoho's domain name (e.g., me@zoho.com) or your own business's domain name (e.g., 
me@example.com). If you want to access your e-mail account using a handheld device, then you can use 
the mobile version of Zoho Mail, which supports Android, iPhone, BlackBerry, Nokia and Windows 
Mobile phones. You can download messages to your local computer, so you can read them and compose 
replies even when not connected to the Internet, using Google Gears. In addition, you can send instant 
messages from within your account. 
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Figure 3. Zoho Mail login.

 
 
The Mail login page also indicates that you would have ample storage space for your messages, but the 
exact limit does not appear to be explicitly indicated anywhere. Some articles on the Web state that there is 
no limit (similar to Yahoo Mail). 
 
As expected, when you log into your e-mail account, you start in the inbox, which is organized in the 
standard fashion, with navigation elements listed in the left-hand sidebar, and the inbox contents shown in 
the (much larger) right-hand panel. 
 

ComputorEdge 9/17/10

14 of 45



 
Figure 4. Zoho Mail account.

 
 
Among the navigation elements on the left, there are the usual folders, but also labels and views. This 
suggests that Zoho Mail combines the folders of Yahoo Mail with the labels of Gmail—possibly the best of 
both worlds. 
 
At the top of the page, in the upper right corner, is a set of navigation links. 
 

 
Figure 5. Zoho Mail navigation

 
 
These links allow you to directly access any one of 14 other Zoho applications, which open in a new 
browser window. The product links are specific to Zoho Mail, such as help information and the FAQ. Note 
that this e-mail service provides keyboard shortcuts, and they are quite similar to those of Gmail. Within 
your Zoho Mail settings, you can add other e-mail addresses and POP accounts, set display options, disable 
keyboard shortcuts, and specify a blacklist and a whitelist of e-mail addresses and domain names (to 
override spam filtering). 
 
All in all, Zoho Mail appears to be quite capable and easy to use. 
 
Word Processing Online 
 
Even though Zoho now offers almost two dozen different applications and utilities, the company started in 
2005 with only one, Zoho Writer (writer.zoho.com/), which is its online answer to Microsoft Word. Zoho 
Writer supports all of the functionality you would expect from a top-of-the-line word processor: text 
formatting, coloring, indentation, bullet lists, images, tables, Internet links, mathematics equations 
(utilizing LaTeX, MathMagic, or MathType), HTML, headers, footers, dynamic fields (similar to those in 
Word), comments, emoticons, a spell checker, dictionary, thesaurus, integration with e-mail, and much 
more. 
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Figure 6. Zoho Writer.

 
 
As part of the aforesaid effort toward interoperability, Zoho Writer supports all the common document 
formats, including Microsoft Word (DOC), OpenOffice.org (SXW), Office Open XML (DOCX), 
OpenDocument text (ODT), RTF, and HTML. In addition, you can easily embed images and video from 
social media sites, including YouTube, Flickr and Vimeo. 
 
Unlike all of the desktop-bound predecessors of the past, Zoho Writer is very much geared toward 
collaboration, and allows the sharing of any document with a select group of users, or publishing it 
publicly. You can enable these readers to add in-line comments and discuss the changes utilizing the built-
in chat capabilities. One advantage to multiple users being able to work on a single instance of a document 
is that you completely avoid all of the problems with having to e-mail the document to others, which 
immediately creates multiple copies, and then multiple versions, assuming that those people start making 
changes to the individual copies that they received. 
 
Spreadsheets Online 
 
In the world of business productivity tools, word processing documents and spreadsheets go together like 
peanut butter and jam. Online number-crunching is made easy with Zoho Sheet (sheet.zoho.com/), which 
in many respects looks similar to Writer. 
 

 
Figure 7. Zoho Sheet.
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Sheet's functionality is also similar to that of Writer, because it makes possible much of the same text 
formatting, although naturally constrained by the context of a spreadsheet. It allows you to publish 
spreadsheets and derived charts to others on the Web, and also perform the same type of collaboration with 
teammates. With a recognition that there are countless existing spreadsheets created using Microsoft Excel, 
there exists a plug-in that allows you to integrate Sheet with Excel. Interestingly, you can set up Sheet so 
that it will automatically process data available as external feeds, in both RSS and Atom format. 
 
So if you have had enough of Microsoft Office's limitations and expense, then consider switching over to 
Zoho, and experience office productivity for the 21st century.
 

Michael J. Ross is a Web developer (www.ross.ws), writer, and freelance editor. He creates Web sites that 
help entrepreneurs turn their ideas into profitable online businesses. 
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Windows 7 Tips and 
Tricks
“Utilizing Windows 7 
Taskbar Tools” by Jack 
Dunning 
 

The taskbar in Windows 7 is 
designed to make our 
computing a little less 
cumbersome. How well it 
works for you will depend 
upon how much you utilize 
the available tools.

 

 
I've complained in the past about how the new quick-launch buttons in the Windows 7 taskbar would not 
operate as a quick launch once one copy of a program has been opened. On first look this is indeed true 
and a little frustrating—especially for those of us who are accustomed to opening multiple program 
windows. Rather than clicking the quick launch for another window after the first window is opened, a 
second (or third) window can be opened by right-clicking on the program icon and selecting the program 
name from the list at the bottom of the jump list (third from the bottom, just above "Unpin this program 
from taskbar").  
 
While this is not particularly a problem, I've discovered that you can temporarily revert your open program 
tab on the taskbar to a quick launch again by holding down the SHIFT key when clicking on the tab. Using 
the Shift key eliminates one of my complaints about the Windows 7 quick-launch/program tabs/jump lists. 
Who knew? 
 
Another useful technique that can be used with the Windows 7 jump lists is pinning a commonly used file 
to the list. (Jump lists are accessed by either right-clicking the program icon on the taskbar or hovering 
over the program name in the Start Menu.) By doing this, it's possible to eliminate either loading the 
program first, then the file, or locating the file with Windows Explorer and double-clicking to load the file 
with the program. (The net result of pinning a file name to a jump list is the same as putting a file shortcut 
on the desktop for quick access, although it is easier to find a pinned shortcut in the jump list for the 
particular program.) 
 
There are a couple of ways to pin files to jump lists. The easiest is to right-click on the program tab (which 
opens the jump list), hover over the desired "Recent" opened file, and click on the pin that will appear at 
the right-hand end of the listing (see Figure 1). This will move the file name to the "Pinned" list at the top. 
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Figure 1. In Windows 7 a file (or other favorite) can be pinned to the jump list by clicking the pin on the right of the 

file name.
 
 
If you haven't recently opened the file, then you can pin it to the jump list by dragging the file name 
(usually in Window Explorer—Window Logo key plus E) to the program tab on the taskbar. (To drag, 
click and hold down the left-mouse button while moving the cursor over the desired program icon on the 
taskbar.) The file shortcut will be added to the "Pinned" list. Whenever you right-click on the program icon 
and select an item from the pinned list, both the program and the target file will be opened. 
 
You can pin folders and libraries to the Windows Explorer taskbar jump list for easy access to specific 
folders. The Pinned list is in essence the same as a favorites list for a specific program. With Web 
browsers, you can pin Web pages to their jump list. When you no longer need the item on the list, you can 
remove it by clicking the pin on the right-hand end (see Figure 2). 
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Figure 2. In Windows 7 a file (or other favorite) can be removed from the jump list by clicking the pin on the right 

of the file name.
 
 
Another technique I found for pinning files and Web pages to a jump list was to drag the file name directly 
from one pinned jump list to another. This is a quick way to share file access between similar types of files. 
 
The taskbar in Windows 7 is designed to make our computing a little less cumbersome. How well it works 
for you will depend upon how much you utilize the available tools.
 

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 
1983. Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached 
at ceeditor@computoredge.com
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Wally Wang's Apple Farm
“Free Office Suites” by Wally Wang 
 

If you don't need all the features of Microsoft Office, you have 
nothing to lose by trying OpenOffice.org, Lotus Symphony or 
NeoOffice. Also, Apple is allowing any development tool for 
creating iPhone/iPad apps; schools continue embracing the 
iPad; virtual keyboards represent the future; Apple may be 
expanding FaceTime to iPads and beyond; and a tip on using 
the Field Test option to display your current iPhone 4 signal 
strength.

 

 
Microsoft is planning to release the next version of Microsoft Office 2011 for the Mac by the end of 
October. This new version of Office will include the Ribbon interface from the Windows version of Office 
and will also include many of the features in Office 2010 for Windows. If you need absolute compatibility 
with Office on Windows, then you might as well wait for Office 2011 for the Mac.  
 
Chances are good that not everyone needs all the features of Microsoft Office. You could always try 
Apple's own $79 iWork suite, but for a free solution, you have nothing to lose by trying OpenOffice.org 
(www.openoffice.org/).  
 
OpenOffice originally began as a commercial office suite called StarOffice. Like Microsoft Office, 
OpenOffice also includes a word processor, spreadsheet and presentation program, but OpenOffice also 
includes a database and a drawing program. By downloading and using OpenOffice, you'll likely have 
nearly every feature you need to do your work, and you never have to pay a thing to use it. 
 
For another option, try NeoOffice (www.neooffice.org), which is basically a repackaged version of 
OpenOffice. Unlike OpenOffice, which must remain compatible with Windows, Linux and Mac OS X, 
NeoOffice focuses strictly on adapting OpenOffice's features for Mac OS X. The current version of 
NeoOffice supports touch gestures on a MacBook trackpad or Magic Trackpad, which OpenOffice does 
not support.  
 
Another unique feature of NeoOffice is its optional NeoOffice Mobile, which lets you access your 
NeoOffice files through an iPhone, iPod Touch, or iPad. You can set up a free NeoMobile account to store 
10 megabytes of data, but for $10 a month, your storage increases up to 100 megabytes.  
 
A third option is Lotus Symphony (symphony.lotus.com/software/lotus/symphony/home.nsf/home) from 
IBM. Like NeoOffice, Lotus Symphony is also based on OpenOffice, but curiously, Lotus Symphony 
offers only a word processor, spreadsheet and presentation program, ignoring OpenOffice's drawing and 
database programs.  
 
One interesting feature of Lotus Symphony is that it provides a tabbed interface so you can quickly switch 
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between all three programs (word processor, spreadsheet, or presentation program) without wading 
through multiple windows.  
 
Probably the biggest disadvantage of Lotus Symphony is that development tends to move at a snail's pace. 
While OpenOffice and NeoOffice keep adding new features, Lotus Symphony trickles out beta versions 
that seem to take forever before they become a final released product. 
 
Comparing all of these OpenOffice variations to Microsoft Office, OpenOffice feels like a generation or 
two behind. Load up Microsoft Office and you'll have a huge variety of templates and clip art you can use 
in your documents. Try that in OpenOffice (NeoOffice or Lotus Symphony), and the available number of 
templates is sparse at best.  
 
If you just need a basic office suite, you can't go wrong with any of these three options. OpenOffice is the 
standard, but NeoOffice tends to be best for Macintosh users who want a uniquely Macintosh version of 
OpenOffice. Lotus Symphony offers a neater tabbed interface for keeping track of multiple documents, 
much like the tabs in a browser.  
 
All three office suites are free (although you should donate some cash to help support NeoOffice if you use 
it), so you have nothing to lose by downloading and trying each suite to see which one you like best. If you 
need to use an office suite on Windows or Linux, then OpenOffice or Lotus Symphony may be better 
choices since they offer versions for all three major operating systems.  
 
Ultimately, it doesn't matter which office suite you use just as long as they help you do something 
productive. These free office suites may not give you the latest features of Microsoft Office, but if you 
don't need those features anyway, you may be happier with one of these free alternatives.  
 
Apple Opens Development to iOS 
 
Earlier this year, Apple banned the use of any development tools to create iPhone/iPad apps unless they 
were written in C, C++, or Objective-C. Ostensibly, Apple claimed that this was to ensure quality control, 
but it was most likely to prevent Adobe from marketing its Flash compiler to use Flash for creating apps. 
 
After Adobe complained, Android's app market started growing like crazy, and the Federal Trade 
Commission (FTC) started to investigate, Apple has finally relented and now allows any development tool 
for creating iPhone/iPad apps. The only restriction is that apps cannot download and run code, which will 
prevent malware apps from sneaking on to your iPhone or iPad and running rogue code to steal passwords 
or credit card numbers. 
 
If you don't want to learn Objective-C, the preferred programming language for iPhone/iPad development, 
wait a few months and you'll soon be able to use revMobile (www.runrev.com/products/revmobile/
overview/), which offers a HyperCard-like programming tool for making development fast and simple for 
non-programmers. 
 
If you're a Flash developer, you can use Flash (labs.adobe.com/technologies/packagerforiphone/) to create 
apps for both the iPhone and Android phones. For the first time, this means you'll be able to create iPhone 
apps from a Windows PC.  
 
(Flash still won't run on the iPhone or iPad. Adobe's Flash compiler simply converts a Flash program into 
binary code that runs on the iPhone or iPad.) 
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Another solution for Windows users is to program in C# using MonoTouch (monotouch.net/). C# is the 
preferred language for Windows development, so you'll be able to use Windows and your knowledge of C# 
to create iPhone apps without having to buy a Macintosh and learn Objective-C. 
 
With so many ways to create iPhone apps, it's likely that Apple's app market will get flooded with low-
quality apps created by amateurs, but it will also get filled with much higher-quality apps that might never 
have been created before. Without Android's growing app market to threaten them, Apple might never 
have opened up iPhone development to everyone, especially programmers using Windows, so expect the 
iPhone and iPad to continue growing its app market ahead of Android. 
 
As Microsoft learned with Windows, once you get hordes of eager developers on your side, they'll support 
your platform and keep it thriving. If you're interested in writing iPhone/iPad apps but don't want to tackle 
the steep learning curve of Objective-C, your options are now wide open to use one of many alternatives. 
 
Schools Continue Embracing the iPad 
 
The Fresno Unified School District is conducting an experiment to determine if students learn better with 
an iPad than with traditional textbooks (www.fresnobee.com/2010/09/08/2071268/no-textbook-case-2-
fresno-schools.html).  
 
Fresno plans to test 100 iPads with middle school students. In addition, 300 students in Long Beach, 
Riverside and San Francisco will also be testing to see if the iPad can replace textbooks.  
 
The textbook publisher, Houghton Mifflin Harcourt, is part of this experiment by developing iPad apps to 
turn the iPad into an interactive textbook. Kurt Madden, the chief technology officer for Fresno Unified, 
said that the school currently uses netbooks in the classroom, but said the iPad is a step up, "like a textbook 
that comes alive." 
 
For some examples of unique iPhone/iPad apps designed for education, visit the following: 
 
Coursesmart (www.coursesmart.com/iphone)—Textbook eReader 
iStudiez Pro (www.istudentpro.com)—Student Planner  
Cram (www.cramapp.com)—Study Tool w/Flashcards & Tests 
Articles (www.sophiestication.com/articles)—Wikipedia 
Grades (www.gradesapp.com/)—Grade Course Calculator 
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Figure 1. CourseSmart can turn your iPhone or iPad into a textbook reader.
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Figure 2. iStudiez Pro acts like a business planner for students.
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Figure 3. Cram helps you prepare and study for a test.
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Figure 4. Grades helps students track their progress to get the best grades.

 
 
Perhaps the success of the iPad is its versatility, at least according to this editorial from the Harvard 
Business Review (blogs.hbr.org/cs/2010/09/the_ipad_and_the_benefits_of_a.html). Rather than position 
the iPad as a niche device, Apple created a blank slate, claims the writer of this editorial. The iPad 
succeeded because it appealed to so many people with diverse needs and managed to solve a variety of 
problems—just like personal computers did back in the age of mainframe computers. 
 
Back in the days when mainframe computers were popular, people looked at the original IBM PC and 
Apple II as "toy" computers that didn't have a clear purpose or defined use. Those mainframe supporters 
probably came up with a million different reasons why personal computers were just a fad and would go 
nowhere.  
 
Rather than heed these critics who actively resist and block change without even bothering to learn the 
basic facts of what they're criticizing, the rest of us can go out and buy whatever we find most useful, such 
as MicroStrategy (www.computerworld.com/s/article/9184419/BI_firm_takes_iPads_over_laptops_), a 
business intelligence software maker, did when it deployed 1,100 iPads to its executives and sales 
personnel. 
 
Mark LaRow, the senior vice-president of products, said that one of the biggest advantages the iPad has 
over a laptop is its instant-on capability. "People don't wait two minutes for it to boot like with a laptop," 
he said. "It's instant on, and that's a big deal." 
 
MicroStrategy's major justification for using the iPad centers around its total cost-of-ownership. LaRow 
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said that MicroStrategy typically spends about $1,000 a year to support a laptop over a three-year life 
cycle, including software licenses, maintenance and hardware. By comparison, the company concluded 
that the iPad would cost just $400 a year, though it is expected they will last only two years, he said.  
 
With so many businesses adopting the iPad and so many schools testing iPads, it's likely that knowing how 
to use an iPad effectively will soon become a school and job requirement. Anyone who refuses to use an 
iPad will simply get left behind like someone applying for a job who refuses to use a computer. 
 
The Virtues of the Virtual Keyboard 
 
Touch typing on the iPad's virtual keyboard takes time, but once you get used to it, it's far more versatile 
than a physical keyboard. Because you're not constantly pressing down on keys, typing on a virtual 
keyboard is actually less stressful. If you've ever typed on a manual typewriter and then used a computer 
keyboard, you'll notice that a manual typewriter requires much more effort to press the keys in the same 
way that a physical computer keyboard requires more effort than a virtual keyboard. 
 
Another advantage of the iPad's virtual keyboard is the ability to suggest words as you type. Once the iPad 
suggests a word that you want, just tap the space bar and the virtual keyboard types the rest of the word for 
you. By using this feature, you can actually type faster and more accurately than with a physical keyboard. 
 
For anyone who needs to type in different languages, a virtual keyboard can easily switch to different 
characters. Surprisingly, Apple's virtual keyboard now even supports the Cherokee language (www.
cherokee.org/NewsRoom/FullStory/3341/Page/Default.aspx). With its ability to display a variety of foreign 
languages, the virtual keyboard lets you communicate in any language you choose without requiring 
convoluted keystrokes or special foreign language keyboards to type the characters you want. 
 
As more people get familiar and comfortable with virtual keyboards, expect them to slowly appear on 
laptops and desktop computers as well. Instead of wrapping a protective plastic film over a physical 
keyboard, you could use a virtual keyboard in a harsh environment without the need for a cover to prevent 
dirt from getting inside the keyboard. There may be a place for physical keyboards, but virtual keyboards 
represent the future.  
 
More Apple FaceTime Rumors 
 
One of the newest features of the iPhone 4 and the latest iPod touch is FaceTime, Apple's open standard for 
videoconferencing through a Wi-Fi connection. Undoubtedly this FaceTime feature will wind up in the 
iPad eventually, but it may come sooner than you might think. 
 
Apple is supposedly mulling over the idea of releasing a new version of the iPad, with FaceTime and back 
and forward-facing cameras soon. If they don't release it before the holiday season, they'll release it 
immediately after in the early part of next year. If you can wait for an iPad, then wait for the camera-
equipped version (unless you specifically don't want a camera).  
 
In their quest to make FaceTime the videoconferencing standard, Apple will likely release Mac OS X and 
possibly even Windows FaceTime programs so you'll be able to videoconference with iPhone 4 and iPod 
Touch users as well as future iPad and Macintosh (and Windows) users.  
 
Since FaceTime is an open standard, expect other mobile phone manufacturers to implement it as well, so 
now you'll be able to videoconference with anyone on the planet, just as long as both of you have an 
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Internet connection.  
 

*                    *                    *
 
If you have an iPhone 4 and want to check its signal strength, just dial *3001#12345#* and press the Call 
button. This will display a signal strength at the top of the screen where the lower the negative number, the 
weaker your signal. 
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Figure 5. The Field Test option displays your current iPhone 4 signal strength.

 

In the early days, before Wally became an Internationally renowned comedian, computer book writer, and 
generally cool guy, Wally Wang used to hang around The Byte Buyer dangling participles with Jack 
Dunning and go to the gym to pump iron with Dan Gookin.  
 
Wally is responsible for the following books: 
 
Microsoft Office 2010 for Dummies (www.amazon.com/gp/product/0470489987?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470489987), 
Beginning Programming for Dummies (www.amazon.com/gp/product/0470088702?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470088702), 
Beginning Programming All-in-One Reference for Dummies (www.amazon.com/gp/product/0470108541?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470108541), 
Breaking Into Acting for Dummies with Larry Garrison (www.amazon.com/gp/product/0764554468?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0764554468),  
Steal This Computer Book 4.0 (www.amazon.com/gp/product/1593271050?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271050), 
My New Mac (www.amazon.com/gp/product/1593271646?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271646), 
My New iPhone (www.amazon.com/gp/product/1593271956?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271956), 
My New iPad (www.amazon.com/gp/product/1593272758?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593272758), 
Strategic Entrepreneurism with Jon Fisher and Gerald Fisher (www.amazon.com/gp/product/1590791894?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1590791894), 
How to Live With a Cat (When You Really Don't Want To) (www.smashwords.com/books/view/18896).  
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When not performing stand-up comedy or writing computer books, he likes to paper trade stocks with the 
video game Stock Reflex (www.plimus.com/jsp/download_trial.jsp?
contractId=1722712&referrer=wwang), using the techniques he learned from a professional Wall Street 
day trader. 
 
In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15 Minute 
Movie Method." (www.15minutemoviemethod.com/) Wally can be reached at wally@computoredge.com.
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Rob, The ComputorTutor: 
Technology Solutions
“OpenOffice.org Word Processing” by Rob 
Spahitz 
 

This month we're exploring a free competitor 
to Microsoft Office: OpenOffice.org. This 
week we'll continue looking at its included 
word processor.

 
 
This month we're exploring a free competitor to Microsoft Office: OpenOffice (OpenOffice.org). This 
week we'll continue looking at its included word processor. (And remember that I'm new to this tool, so I'm 
reporting not just what I find, but also whether I find things challenging.) 
 
The New Gazette 
 
Let's look at something a little more complicated than a simple letter with a few paragraphs. Let's start by 
making something that looks like a newspaper. 
 
A few things that we'll need when we make a newspaper are columns and pictures. Let me start with a nice 
heading. 
 
I see that under the Insert menu, I can add a heading. From the menu, it apparently lets you pick one of 
several options, but since I never set any, I only have the choice of Default. Selecting that adds a new 
section at the top of the page, as seen in Figure 1. 
 

 
Figure 1. Write Tool Header.

 
 
Notice how there is a small, wide gray box behind the menu. That's the outline for your header. 
 
Adding some text is easy enough. And centering it is as simple as clicking on the image near the 
"BUI" (bold/italics/underline) buttons in the toolbar, also seen in Figure 1. Similarly, I can change the font 
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style, color and size. The one thing I noticed is that I cannot select the entire row of text from the left edge 
as I've commonly done in Word and just about every other text editor I've used. That's not a big deal since I 
can still click and drag across the text, but it was nice to have a single-click option to select the row. 
 
Now a thought: Add a nice box around the heading. Let's see if I can find an option for that (and I'm not 
sure if Word has that feature either, other than adding a separate box rather than using the existing 
heading's paragraph to create the box). And the answer is ... with a little searching, I found that I can right-
click next to the text and choose Paragraph. The dialog box shown in Figure 2 has several options, 
including a tab entitled Borders. Within this, on the left side is something called "Line arrangement" and 
beneath that I can choose a solid box (or I could have changed a user-defined area, similar to defining 
borders in Word). 
 

 
Figure 2. Paragraph Borders.

 
 
When this border was selected (and the OK button was clicked), I got a border around the heading, as seen 
in Figure 3. 
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Figure 3. Heading Border.

 
 
OK, mission accomplished. And obviously, a heading on a page is a bit different from a heading on a 
newspaper, but it's nice to know what features a tool offers. 
 
Now on to the top stories. For this, I'd like to create three columns for various articles. Clicking on the 
body of the document is a bit easier than with Word. In Word, the Header and Footer are treated as 
separate pieces to edit; to get back to the body, you either close them or double-click on the body. Here 
you can simply click to get there. Although on the surface that looks better, I can see how if you're not 
careful you could accidentally click in the header and start typing, then have to undo it to put it back into 
the body. I would consider this difference a matter of preference. 
 
I began by checking the Insert menu for columns but nothing is there, although I see something called 
Sections. Let me keep searching first. Ah, there it is under the Format menu. Not my first choice in places 
to look, but not too far off either. With this, I see the dialog box shown in Figure 4 after I change from one 
(1) to three (3) columns. 
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Figure 4. Page Columns.

 
 
After clicking the OK button, since I don't really need to make other adjustments at this point, I get the 
body of the document split into three, with three gray boxes to designate the boundaries. 
 
Now, after adding some article information in the first two columns, I'll add a picture to the top of the third 
column. 
 
As I start entering data into the second column, I realize that I made a mistake. Columns in a word 
processing document are different from columns in a newspaper. In a word processor, it's simply a way to 
make the text a bit easier to read (with text not so wide) and the text simply wraps from one column into 
the next. However, in a newspaper, columns represent different documents. So let me look around again to 
see if there's a feature for this. First a few Ctrl+Z's to see if I can undo the last few entries (since that has 
become the de facto command for undo). And sure enough, that works here too. 
 
Newspaper Columns 
 
Let's go back to that Section entry I saw in the Insert menu. As above, I see that this also has Columns, as 
seen in Figure 5. 
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Figure 5. Page with Column Sections.

 
 
Clicking on the Insert menu shows what looks like a box across, showing three sections. However, these 
columns also work together, and I need independent columns, so undo those too. 
 
My next thought was to add a Frame, also found in the Insert menu. With that, I should be able to add text 
to boxes that appear like columns. When I select this, the dialog box shown in Figure 6 appears. 
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Figure 6. Page Frames.

 
 
With a simple click of the OK button, the frame appears in the middle of the section along with a little 
button with an anchor (to allow you to return to the properties of the frame as needed) as seen in Figure 7. 
 

 
Figure 7. Frame on Page.

 
 
By aligning this to the left (manually dragged) and resizing it to fit one-third of the page, it looks like a 
column. With a little effort and some copy-pasting, I was able to get the adjacent columns and enter some 
text in the first and second columns. 
 
In fairness, although this seemed a bit non-intuitive, the idea of newspaper columns is not a function easily 
supported by Word or most word processors. These are really better handled by page-layout tools designed 
for desktop publishing. 
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OK, let's wrap things up by inserting a picture into the top of the third column, then resizing it to fit the 
column width. On the Insert menu, there is an option for Picture with a flyout menu to choose "From File" 
or from a scanner (which may only show up if Write recognizes a scanner on your system). Choosing File, 
I can select any picture. And surprisingly, it automatically adjusts to the column width if too wide. 
Excellent! It also gives you an anchor button if you'd like to adjust picture properties. 
 
My final result at this point appears in Figure 8. 
 

 
Figure 8. Completed Newspaper.

 
 
Next week we'll explore a few more features of Write. So far it looks like a great, and free, alternative to 
Microsoft Word.
 

Rob has been in the computer industry for over 25 years and is currently a part-time teacher, offering 
classes in Excel, Access, Visual Basic, and a variety of other technical tools. He has loved ComputorEdge 
since 1990 and can be contacted at RSpahitz@Dogopoly.com. 
 
Looking for a great boardgame? Grab a copy from DOGOPOLY.com (dogopoly.com) and 
have a dog-gone great time.
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Beyond Personal 
Computing: Spam, Ham 
and Related Scams
“A Look at the Human Side of 
Computing” by Marilyn K. Martin 
 

Your spam file could probably more 
accurately be called your "scam" file. 
Hit Delete and remember, the money 
you really save was yours to begin with.

 

 
Have you ever sat down and actually read through your bulging e-mail spam file some morning? It spawns 
endlessly amazing questions in my mind. So how many total strangers out there really think I'm their Dear 
Friend or Dearly Beloved? Why do all these amazing offers and sob stories never address me by name? 
How come I never knew that Microsoft runs a lottery in Britain? Does anyone in West Africa have an 
honest job? With all those pitiful people needing help in various countries, why is the return spam always 
addressed to Hong Kong? (Just check the very last couple of letters at the end of the return address for the 
country of origin, if outside the U.S.) 
 
Lately, however, my spam file could more accurately be called my "scam" file. I'm probably partly to 
blame, since I industriously "unsubscribed" from all those Health Spa, Real Estate, Exercise Equipment, 
Restaurant Coupon, Mysterious Shoppers Needed, Court Reporting School and Vacation Deal ads. So now 
my spam file is downsized, but filled with tons of English-as-a-third-language pleas for help.  
 
Most of these spam-scams start out that, due to some convoluted circumstances, some stranger on the other 
side of the globe desperately needs me to help them, with the lure of substantial sums for my good-natured 
participation. This usually involves a huge amount of money that has been discovered, or discovered but 
locked away, which that person in his/her present circumstances can't, or doesn't dare, access. This 
mysterious vast sum needs to be sent to my bank account, you see, and I can retain a generous 30-50 
percent for my participation. (Even if this phish-tale was real, do these strangers really think Americans 
suffering through a recession would actually send them their "rightful share" of the other 50-70 percent?)  
 
Sometimes the deal includes a sob story. A destitute widow who can't access her dead husband's fortune, 
and you get paragraph upon paragraph upon paragraph of what a fine upstanding citizen he/she is, or the 
deceased spouse was. Or there is the pending death of the sender, so I need to respond this very second. 
Sometimes there's even a link to some legit online article that may vaguely reference the sender's scam. 
And, of course, all I have to do is send back all my personal and financial information. 
 
Sometimes the "from" address at the top is a collection of official-sounding Right Honorable this, and 
President of the Bank that. These official-sounding spam scams are usually an attempt to make me think 
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that I am terribly important to these terribly important senders. These kinds of spam can be filled with 
sugar-coated introductions, where they've heard that I am a "nicely honest person of good character." Or 
that I was recommended to them by a nameless "mutual associate in good standing who said of you could 
be trustedly honest." 
 
One variation is the undeliverable inheritance or undeliverable parcel in my name. It's being held in a 
country I've never visited, nor do I know of anyone who has visited there, relatives included. To claim this 
mysterious amount, all I need to do is send them all my personal and financial information. Or wire such 
information and some money, to a courier currently cooling his heels in a New York or Chicago airport, so 
they can complete their journey to hand me that all-important parcel or inheritance check. 
 
My personal favorite in this category was the spam informing me that my brother had died in Thailand, and 
left me a sizeable inheritance. And, of course, they need all my personal and financial information to have 
this sum wired to my bank account. I suppose that enough recipients might just have a brother, and it might 
be reasonable to assume that the low-life may have actually struck gold in some overseas adventure. But I 
come from a family of all girls. The good news is that this spam scam arrived on Mother's Day, and my 
mother and I got to share a laugh over my "deceased brother in Thailand." 
 
Occasionally I get an Important! announcement from a legit-name bank, Internet money account or the 
FBI. There has been an unauthorized transaction to my bank account, see, or they have information that my 
account has been compromised. I need to Immediately! verify all my personal and financial information, so 
that they can straighten everything out.  
 
A curious recent approach I've noticed are the Time Travel spam. It's spam from the future or past. No 
kidding! I actually opened one spam from the year 2037. It was a very current-looking ad for a Rest Home. 
Which is strange. From what science fiction I've read or seen in movies, oldsters in the future will 1) Be 
required to expire at age 40, 2) All be wafer-ized to feed the young, or 3) Seniors will have so many bionic 
parts that Grandma will be in a relationship with a hunky refrigerator, and Grandpa will be the brains—
literally—of a rocket taking tourists to Jupiter. Thus, no need for rest homes in 2037.  
 
More recent spam scams I've noticed are more along the lines of scare tactics. I got a lengthy spam that I 
need to join that sender in "testifying" against some bad third party. Or someone warning me about a virus-
laden spam/advertisement that I may have received. And I must open the attachment, to view this 
dangerous spam/ad to see if I recognize it. 
 
Sometimes you can tell by the headline in your spam listings that you don't need to bother opening the e-
mail before you delete it. "Sanitary Foreigners Wanting Spouses," "Trusting in Loving God You To 
Answerment," and "Bigger (Body Part)" always gets the ole' heave-ho Delete without being opened. 
 
Spam, Ham and Scams Tips 
 
1. No legitimate operation will ask you for your personal and financial information by return e-mail. Your 
bank account will be drained, soon to pop up under "Jonastumble Q. Bibberbunch's" name in a Caribbean 
bank account. 
 
2. Never open a spam attachment! Most of those come loaded with enough nasty viruses to crash your 
computer in a millisecond. 
 
3. If it's a genuine advertisement, scroll to the bottom and look for the Unsubscribe option. Sometimes it 
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may take a week to 10 days for the "unsubscribe" to kick in and stop sending you all the ads. But 
sometimes a lot of other bothersome spam will vanish too, since they were being sent by the same 
company. 
 
4. If you get a "phishing" spam that, regardless of the sob story, asks for your personal and/or financial 
information, hit the Return To Sender button. Then change the "To" line to spam@uce.gov. This will send 
this fishy-phish to the government, before some curious kid or desperate adult takes them up on their offer. 
 
And remember: The money you really save was yours to begin with.
 

Marilyn K. Martin is a freelance writer of nonfiction and fiction living in East Texas. She is the author of 
several published mini-articles and is currently writing a Young Adult Science Fiction series, Chronicles of 
Mathias, (www.amazon.com/Chronicles-Mathias-One-Reptilian-Rebirth/dp/1598249002) Volume One and 
Two are available on Amazon. 
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EdgeWord: Low Cost Remote 
Assistance Programs
“With software, you don't always get what you pay 
for.” by Jack Dunning 
 

With so much free software on the market, it's difficult to see 
why anyone would be paying for it. Jack explores 
alternatives to expensive remote-assistance programs.

 
 
With so much free software on the market, it's difficult to see why anyone would be paying for it. I guess 
that some people may be trapped into Microsoft Office by compatibility issues, but in those situations it's 
usually a corporate entity that's paying for it. Whenever I'm looking for a particular solution, I can usually 
find a free version of the software somewhere. 
 
As open-source software continues to improve, it's becoming a real threat to commercial versions of the 
same types of programs. This keeps the pressure on for the commercial companies to be even better. 
Overall it makes better software more available while keeping the cost down. 
 
For example, I've recently been looking into remote-assistance programs. In addition to programs such as 
GoToAssist from the widely advertised GoToMyPC crowd, there is a huge range of similar offerings from 
other sources—many of them free. Even the commercial providers almost universally have a free-for-
private-use version of their remote-assistance system. The free versions of the commercial programs are 
usually limited in how much they can be used, but could be ideal for anyone needing to remotely access 
their grandmother's computer. However, there are some programs that are free—whether for commercial or 
personal use, such as Mikogo (www.mikogo.com/), Zolved (www.zolved.com/remote_control) and Kesaya 
(www.kaseya.com/free.aspx). (I haven't used any of these programs, so I can't give an opinion on them yet.) 
Compared to the $660 per year charged by GoToAssist and the $1,188 per year charged by LogMeIn 
Rescue, those programs sound like a pretty good deal. 
 
Zoho, the free business suite of programs reviewed this week by Michael Ross, includes Zoho Assist 
(meeting.zoho.com/home.do). The free version is limited to five sessions per month and two hours per 
session, however it is only $115 per year for unlimited use for one technician. That's one-tenth of 
GoToAssist. I'm sure that there are differences in services offered, although they are not necessarily on the 
side of the more expensive service. CrossLoop (www.crossloop.com) has a free version with unlimited 
screen sharing and unlimited remote control for $69.50 per year. 
 
Another approach to marketing this type of program is to pay a one-time lifetime fee. This is used by 
TeamViewer (www.teamviewer.com/solutions/remoteaccess.aspx), one of the more popular services. 
TeamViewer offers a free version for non-commercial use, but for business use they charge one-time fees 
starting at $749. DualDesk (www.dualdesk.com/) has a free trial with a one-time charge starting at $395 per 
technician. 
 
Windows does have a Remote Assistance program built into the operating system, but people rarely 
remember to try it. If both machines are Windows 7, then they should be able to hook up with easy 
connect. However, I was unable to get that approach to work and didn't bother to figure out why. It was 
already too much of a hassle. There is a Windows Remote Assistance between two Windows machines 
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(Windows 7, Vista, or XP), which uses e-mail to establish a connection. I have used this and it does work. 
 
I think that many people pay high prices for some commercial programs not because they are better, but 
because it's all they know. They see an ad on television or hear one on the radio and go from there—no 
research. There are many more remote-assistance programs available. I plan to take a closer look at the 
features of some of those that I've mentioned here.
 

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 
1983. Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached 
at ceeditor@computoredge.com
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Editor's Letters: Tips and Thoughts 
from Readers
“Computer and Internet tips, plus comments on the 
articles and columns.” by ComputorEdge Staff 
 

"File-Compression Programs," "Redirect LPT1 to USB 
Printer," "Windows Speeder-Uppers," "Skydrive"

 

 
File-Compression Programs 
 
[Regarding Michael J. Ross' September 3 article, "File-Compression Programs":] 
 
I was anxious to learn about how compressing files could improve the PC's performance and speed, but the 
article only referred to better Web performance—nothing about whether or how compressing files affects a 
PC's performance. Is it slower to access a file on a hard disk because it has to be decompressed before it 
can be opened, or is the net result faster because of the smaller file being retrieved? 
 
All in all, though, it's a pleasure to read such a well written article, and it gave a great review of 
compression programs! 
 
I have come to depend heavily on a desktop search tool for quickly finding e-mails and files (Yahoo 
Desktop Search, which became X1—a fantastic tool, and now Windows 7 has its own text search 
capability). The question: Do these search tools still work on compressed files? 
 
-Dave Amen, Centennial, CO 
 
This is a very useful tip. 
 
Thank you very much for providing this helpful article. 
 
-Richard, Encinitas, CA  
 
Redirect LPT1 to USB Printer 
 
[Regarding the March 5 Digital Dave column:] 
 
My favorite tool is Printfil (www.printfil.com). Unlike the competitors, it offers several extras, like print 
preview, direct PDF export, e-mailing, BMP merging, archiving and other utilities. Without them I couldn't 
have really transformed my legacy program into a modern PDF invoicing system for my customers. 
 
-M. Donez 
 
Windows Speeder-Uppers 
 
[Regarding the September 3 Digital Dave column:] 
 
One of my very faves is PageDefrag (technet.microsoft.com/en-us/sysinternals/bb897426.aspx) [Windows 

ComputorEdge 9/17/10

44 of 45



32-bit program]. It is a very small boot-time utility that defrags your pagefile.sys before Windows loads. 
I'd be lost without it. 
 
-Pete Maurer, Rosarito Beach, Baja California 
 
I use Crap Cleaner and Glary Utilities. Actually, I have no way of telling if they are doing their job. All I 
know is that using them several times a week keeps my access speed hopping. 
 
-John Cultrera, Temecula, CA 
 
I agree with Steve in Escondido. I stopped paying for PC Tools' Spyware Doctor and Registry Mechanic 
and use Glary Utilities exclusively. It does a great job and is free! 
 
-Poz 
 
Skydrive 
 
[Regarding Pete Choppin's September 3 article, "Windows Skydrive for Data Storage":] 
 
I hear what Pete is saying about the future being in the cloud. You can't buy more storage than that 
(assuming you take advantage of all the free storage there is out there). I've been in the cloud for some time 
now; I use Hotmail, now a feature of Windows Live. And while I do appreciate the ability to access my 
mail from anywhere, I also realize that in spite of the settings I designate, i.e.: "share," "don't share," 
"private," whatever, I also realize that there is still one party that can read any and all documents stored in 
the cloud: Microsoft, or whomever you select as your file storage maintenance organization. That is one 
aspect not mentioned in the article—the loss of privacy. Isn't that what we all sign away when we check 
"agree" on the terms and conditions that are commonplace to the majority of these services? 
 
-Joe Piluso, San Diego
 

ComputorEdge always wants to hear from you, our readers. If you have specific comments about one of 
our articles, please click the "Tell us what you think about this article!" link at the top or bottom of the 
article/column. Your comments will be attached to the column and may appear at a later time in the 
"Editor's Letters" section. 
 
If you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at 
ceeditor@computoredge.com.
 

 
Send mail to ceeditor@computoredge.com with questions about editorial content. 

Send mail to cewebmaster@computoredge.com with questions or comments about this Web site. 
Copyright © 1997-2010 The Byte Buyer, Inc. 

 
ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 573-0315 
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